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PaintLink Manual

Introduction:

ArtRage Vitae can allow you to share a canvas with a friend and collaborate on a painting together.
This tutorial is designed to help you get started painting with a friend on a shared ArtRage canvas.

To use this tutorial you will need a basic understanding of how to use ArtRage, and you will need to
have an internet connection. This tutorial won’t help you solve internet connection issues — you
may need to talk to an internet technical person.

In places this manual uses a highlight frame to draw your attention to part of
the ArtRage Ul. These frames don’t form part of the ArtRage Ul - they won’t :
appear in ArtRage Vitae.

Note that the chat features of ArtRage Vitae are basic. The messaging is to help synchronise with a
friend and to let you share ArtRage content and assets easily. We’re not trying to replace your
existing messaging or social media apps. We don’t want to be a Social Media company!

You can find the latest version of this document at: https://www.paintlink.net/help



https://www.paintlink.net/help
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Getting Started:

By default ArtRage hides the PaintLink interface. This keeps the ArtRage user experience free of clutter.
PaintLink adds new controls and options to almost every part of ArtRage which may be distracting to artists
who aren’t interested in collaborating. You only need to enable the PaintLink interface and create a PaintLink
account once. ArtRage will remember your settings for next time.

You will also need to create a PaintLink account so ArtRage can connect you to another ArtRage user.

Enable the PaintLink User Interface:

Before we can start using PaintLink to share a canvas we need to enable the PaintLink functionality. This is set
in the ArtRage Preferences. If you've already been through this step you don’t need to re-enable the
PaintLink Ul. ArtRage will remember your preferences.

* Run ArtRage Vitae.
AriRage Preferences B
* From the ArtRage ‘Edit’ menu, choose oraun

‘ArtRage Preferences...” This will open the
ArtRage Preferences Panel.

Reset Choose

, , ) It you are experiencing problems with Multithreading, or
* Expand the ‘Advanced Preferences’ section wish to use only one processor, turn Use Multithreading off.

of the panel by clicking on the ‘Advanced

Use Multithreading | v
Preferences’ bar.

_ , JPEG Quality -
* Scroll the panel down to find the ‘Enable ( ) ) °
PaintLink .UI .checkb.ox and t_urn on the Store Backup Files .
‘Enable PaintLink’ option. (Yes, it does make ) ‘
that sound.) f\uto Save Timeout (minutes) [ e0

* C(lick ‘Ok’. ArtRage will pop up a notice ,
Force Whole Pixel Placement | v

saying you need to restart ArtRage. This is —
normal — ArtRage needs to rebuild the user
interface. Click OK. v

Innut Device A

Cancel OK

* Exit ArtRage. Either click the Windows close button, or from the ArtRage ‘File’ menu choose ‘Quit
Application’. If you’ve done any painting you may be asked to save your work.

* Start ArtRage Vitae again.

* Now you should see a new icon in your ArtRage Toolbar at the top of the window. Q .é

This means the PaintLink Ul has been enabled inside ArtRage.
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Create a PaintLink Account:
To connect to another ArtRage user and to allow them to connect to us we need to create a PaintLink
account. You only need to do this the first time. If you've already been through this step you don’t need to
create a new PaintLink account.

® C(lick the PaintLink icon in the ArtRage Toolbar: Q ‘é

* This will bring up the ‘Connect to PaintLink’ panel. (Note: If it brings up your PaintLink Friends List
instead this means you’ve already created a PaintLink Account and logged into the PaintLink server)

* In the ‘Connect to PaintLink’ panel ensure the
‘Remember Login Details’ checkbox is on, and Connect to PaintLink
the ‘Auto-connect when ArtRage Starts’
option is on.  This will allow ArtRage to A% ,
automatically connect and log in to the W
PaintLink server when ArtRage starts up.

Login
User Name:

o If you are on a shared computer you
may want to turn off ‘Remember
Login Details’ Password:

. Forgot Password or User Name >
o If you are on a slow internet

connection you may want to turn off or.
‘Auto-connect when ArtRage Starts’ —

on some slow connections it can Remember Login Details | v
cause ArtRage to take a long time
starting up.

Create a PaintLink Account >

Auto-Connect when AriRage Starts | v/

Cancel Login

* C(lick on the bar labelled ‘Create a PaintLink Account’
This will open a web page on the PaintLink.net server.
You can also click this link to open the web page: Create An Account : PaintLink

* Now you can create your PaintLink Account. You will need to enter the following information:

o Login: This is your unique username. It is how people will find you in their Friends List. It
cannot be changed once you create the account. You can use characters and numbers but no
spaces in your name. Something like ‘jane_smith’ is valid. Or ‘jsmith34’, for example, but
‘jane smith’ is not valid. If the name is already in use by someone else you will need to
choose something unique —adding more numbers to your name might work.

o Password: This keeps your account secure. Choose something with a combination of letters,
numbers, and ‘special characters’. You will need to remember this password, but not want
other people to be able to guess it. If you get a message saying ‘Password is weak’ add more
numbers, special characters, or make your password longer.

o Confirm password: Enter your chosen password again, just to make sure you got it right.

o Private email: Enter your email address. If you lose your login or password details we will
need your email address to restore your PaintLink account.


https://www.paintlink.net/create/
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o And click the ‘I'm not a robot’ checkbox. (If you are a robot, please ask a nearby human to
click this checkbox for you)

* When you've completed the above details, click the ‘Register’ button, which will create your
PaintLink account. You should see the message “Account jsmith34@xmpp.artrage.com has been

successfully registered.” (but with your name instead of mine. ®)

Your PaintLink account is now ready to use with ArtRage.

Connect to your PaintLink Account:
If you’ve enabled your PaintLink interface in ArtRage and created your PaintLink account on the PaintLink.net
server you’re ready to connect ArtRage to your PaintLink account.

* Switch back to ArtRage Vitae.

* If you've closed the ‘Connect to PaintLink’ panel re-open the panel by clicking the PaintLink icon in
the ArtRage toolbar at the top of the window. Or from the ArtRage ‘Tools’ menu, choose the
‘PaintLink’ submenu, and ‘Log in’

* In the ‘Connect to PaintLink’ panel you can enter the login and password you selected when you
created your PaintLink account.

o In the ‘User Name’ box enter the Connect to PaintLink
login you chose

o In the ‘Password’ box enter the / &é@ /

password you chose.

o If you forget your account name or
password you can click the ‘Forgot
Password or User Name’ link to
take you to the PaintLink account POSSWOTT: [* %% *¥Ahaohhdekwwen
web pages.

Login
User Name: |jsmith34

Forgot Password or User Name >

o If you want ArtRage to connect to
PaintLink next time you start, make
sure both of ‘Remember Login
Details’ and Auto-Connect when
ArtRage Starts’ checkboxes are Auto-Connect when AriRage Starts | v
turned on.

Or... Create a PaintLink Account >

Remember Login Details | v/

Cancel Login
* Click the ‘Login’ button. g
* The ‘Connect to PaintLink’ panel will briefly
display ‘Logging in’, before the ‘Login Successful’ message in the panel.

o If the panel gets stuck on the ‘Logging in’ message for more than 10 seconds you may have a
problem with your internet connection, or your firewall may be preventing ArtRage from
accessing the Internet. You may need to get technical help to allow ArtRage access to your
internet.

o If a message box pops up with ‘Login Problem’ you probably entered your username or
password incorrectly. Click ‘Ok’ to go back to the ‘Connect to PaintLink’ panel and carefully
re-enter your correct details.
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o Click the ‘Ok’ button to return to ArtRage.

You have now connected ArtRage Vitae to your PaintLink.net account. The PaintLink icon in the @ ~§§
ArtRage toolbar should be showing your connected status:

If you get an error saying your user name or password is incorrect, or if you've forgotten them, use the links
on the PaintLink Connection panel to reset your password.

Set up your user profile:
You can add a small icon to identify yourself and add a few details about yourself in your user profile (if you
want!). You can skip this step if you prefer to remain all mysterious.

* From the ArtRage ‘Tools’ menu, select the ‘PaintLink’ submenu. Then choose the ‘Account Settings...’
option.

* This opens the ‘Account Settings...” panel where you can set some personal data.

* You can add an Avatar which is a small picture so your friends can quickly identify you in their Friends

List.

o Click o'n the head icon or menu Account Seffings. .
popup icon above your username.

o Select ‘Set Avatar Image...’

o From the file browser choose a B
picture that you feel represents jsmith34
your true self.

B AboutMe

o The picture will be shrunk down

and added to your user profile as Jane Smith. Artist. Significant Person. | once gifted a

friend with 5 kilograms of grated cheese for their birthday.
your Avatar. It was that or 20 pumpkins.

o Click the ‘Update’ button if you are
finished, or edit your ‘About Me’
details as follows

Cancel Update

* You can edit your ‘About Me’ information which gives a small biography about you.
o Click the menu button next to the ‘About Me’ label
o Select the ‘Edit Profile Text..." option.
o Enter some details about you so your friends know who you are.

o Click the ‘Update’ button to save your Avatar and biography.

Add Friends to your Friends list.

ArtRage keeps a list of people you want to chat and paint with. You can tell when your friends are also
connected to the PaintLink server and you can use the Friends List to send messages and start a shared
canvas PaintLink session.

* Make sure you're logged in and connected to your PaintLink account: [Connect to your PaintLink
Account:]
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* Open your ArtRage Friends List
o Click the PaintLink icon in your ArtRage toolbar at the top of the window.

o Or from the ArtRage ‘Tools’ menu, choose the ‘PaintLink’ submenu, then the ‘Friends List’

option.
*  Find out your friend’s PaintLink username.
Friends X
o You can find people on the ArtRage Forums: ArtRage
Forums ﬂ © jsmith34 >

o Talk to your friends on FaceBook and Twitter — see if they ® —/

own a copy of ArtRage Vitae. Convince them to create a

PaintLink account. A

o Talk to your friends on other social media.

* In your Friends List click ‘Add New Friend’ button. Or from the
ArtRage ‘Tools’ menu, choose the ‘PaintLink’ submenu, then the
‘Add Friend...” option.

* |In the ‘Add New Friend’ panel type in the ArtRage PaintLink
username of your friend and click ‘OK’.

o Repeat for every friend you want to add to your ArtRage
Friends List

* Important Note: When you add a friend to your Friends List they
will get a notification in their ArtRage PaintLink panel. They can
choose to accept your invitation, in which case they’re now one of
your friends. Or they can decline, in which case you don’t get to
see when they’re online. Similarly when someone else adds you
to their Friends List you’ll get a notification. You can choose to
accept or decline them as a friend. ﬂ © jsmith34 >

Or you can both add each other to your respective Friends List and
that works as well. ® —/ N+

Friends X

*  Your Friends List should look something like this.
In the example andyrage is a friend, but isn’t online. vin_goff is a
friend and is online — we can chat and share a canvas with them.
The other friends are offline (or may not have accepted our
invitation)

andyrage

mw|o

N
9

.| vin_goft

You’re now all set up and ready to chat to a friend, and start a collaborative
painting session on a shared canvas. brain2000

arfragemac

m o | o | @


https://forums.artrage.com/
https://forums.artrage.com/
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If it All Goes Wrong...
Don’t panic! There are some things we can check to see why the process of adding your friends isn’t working.

Check you’re logged in to the PaintLink Server. The connection may have dropped and you may need
to log back in. The PaintLink icon in the taskbar should have a yellow-green dot if you’re connected.
If it isn’t connected log in to your PaintLink account again: [Connect to your PaintLink Account:]

Are your friends actually online and connected? If they’re not showing as connected in your Friends
List it might be they’re having problems.

Try logging out, and logging back in again. From the ArtRage ‘Tools’” menu, select the ‘PaintLink’
submenu, and choose ‘Log out’. Then try logging in again. That will reset your connection and
reload your Friends List

Restart ArtRage. If you can’t connect by logging in, shut down ArtRage and start it up again. That
will make sure PaintLink is starting from afresh.

Are you sure your Internet connection is good, and that ArtRage Vitae is allowed access to the
Internet? You may need to check your firewall settings or security settings.



ArtRage Vitae - PaintLink Manual.

Page 9

Chat with a Friend:

Using PaintLink in ArtRage Vitae you can have a conversation with friends in your Friends List. You can also
send and receive ArtRage content such as brush settings, reference images, stencils, canvas settings and
other content. Content you receive can be immediately added to your ArtRage paintings. Note that you don’t
need to be collaborating on a painting and sharing a canvas. You can send and receive ArtRage content with

any of your friends if they’re online.

Start a chat

Make sure you’re logged in and connected to your PaintLink account: [Connect to your PaintLink

Account:]

Open your ArtRage Friends List

o Click the PaintLink icon in your ArtRage toolbar at the top of the window.

o Or from the ArtRage ‘Tools’ menu, choose the ‘PaintLink’ submenu, then the ‘Friends List’

option.

Click on the small speech bubble next to your friend’s name, or
click on the menu icon next to their name and choose ‘Open
Chat’

You can type a message to send in the text entry at the bottom
of the chat window. Then hit ‘Enter’ on your keyboard, or click
the arrow icon >’ to the right of your text entry to send the
message to your friend.

Your message will appear in the chat window next to your icon
avatar.

Messages received from your friend will appear in the chat
window next to their icon avatar.

In this example you can see jsmith34 is chatting with one of
their ArtRage friends called vin_goff

You can have more than one chat window open at a time — chat
with as many friends at once as you like.

X
>
Hey therel How's your day going? A
Peachy! The sun is out, the birds are singing.
It's a great day for a walk in the forest. :)
That sounds great. It's raining here.
Wanna work on a painting together?
\%

Friends

ﬂ o jsmith34

pak

+

andyrage
. vin_goff
brain2000

arfragemac

m oY @O

o | @D
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Send ArtRage Content to a Friend:

You can send ArtRage content to anyone in your Friends List. For example you can send the settings for one
of your tools to a friend. Your friend will be able to use the tool with the same settings when they receive it.

Things you can send directly to your friend
The list of content you can send and receive is:

Images, such as PNG or JPG.
Preview of your entire painting — if you want to show off what you’re working on.

Reference images. This sends the reference image how it is pinned to your canvas, so it will be
pinned in the same way to your friend’s canvas.

Tracing Paper image. The tracing paper is sent with the same scaling and opacity to your friend.
Stencils, Friskets and rulers.

Selection sets or selected areas.

Tool settings.

Canvas paper settings.

Packages. If you've created an ArtRage content package you can send it directly to your PaintLink
friend

Grids, Guides, and Perspective guides.

Sticker Sheet.

Colour with metallic setting. Send the current colour you’re using to a friend.
Swatches.

Symmetry settings.

Colour Blending profiles.

All of the content in the above list can be directly added to your current painting when you receive it. In your
chat window next to the received item is an arrow “>" which gives the option to ‘Add Now’ to your painting.

Other types of content can be sent, and added to your Collections.

Gradients. For use in Fills

Tool Preset.

Actions. Recorded actions and hand-written ArtRage Script actions can be sent.
Brush heads for the custom brush tool.

Patterns. For use in Fill tools.

Canvas Presets.

Canvas Grains.

Custom colour picker content.

Stencils from the resource collection.

Colour Blending Profile from their resource collection.
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The content can be added directly to your ArtRage resource collections when you receive them.

That sounds great. It's raining here.
In this image jsmith34 is chatting to vin_goff.

Jsmith32 sent a photograph of a tree to vin_goff.
vin_goff replied by sending their current tool settings.

Wanna work on a painting together?

IMG_1793.JPG
Completed
)
VR / . Tool Settings - Pastel .

Completed

v

How to send something
There are several ways to send content to your ArtRage friend.

* From the menu PaintLink chat window with your friend
o Start a messaging session with a friend: [Start a chat]

o Inthe lower-right of the chat window — to the right of your message entry box — there’s a ‘+
icon. Click that to open a menu of things you can immediately send to your friend.

Chatting With... X

.| vin_goft >

That sounds great. It's raining here. A

@ Wanna work on a painting together?

Completed

ﬂ & IMG_1793.JPG >
|
- / . Tool Seffings - Pastel S

Completed

Send Image...

Send Current Canvas Preview...

Send Package File...

o You can send an image file, such as a PNG or JPG photo. Or you can send a preview of your
current painting — show off what you’re working on! Or you can send an ArtRage Package
file you’ve created.
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* From the menu at the top of settings and content panels
o Open the Settings panel.
o Click the menu icon to the right of the panel title.
o From the menu choose ‘Send to a Friend’
o Alist of your friends who are currently also connected to the PaintLink server will appear.

o Select the friend you want to send the content to.

Seftings B Set Stylus Properties...

Stylus Control Center...
‘)/ Presets... New Preset... Ctrl+Shift+P

Default Setti
wax Chalk B

— Send to Friend > vin_goff
Pressure . [ 307y

Softness [ B2%

Noise Amount

| 0%

Noise Scale ‘ 50

* From the context menu in the content panel.
o Open the Sticker Sheet panel.
o Right-click on a sticker sheet preview to open the context menu for the sticker sheet.
o From the menu choose ‘Send to a Friend’
o Alist of your friends who are currently also connected to the PaintLink server will appear.

o Select the friend you want to send the content to.

Sticker Sheets B | X
Add Group Import Stickers New
Favorites 09O0® w
P W N ~\
= Q : : Delete Item... ’
A Character Sets ®cC Rename Item...
Ba Move Item...
Glossy
Duplicate ltem
Hair + Fur © €
O G Send to Friend > vin_goff
Nawe | QQ@D@ |
Stamps 000e | REREEEE

| Bright Baubles Dominoes
v Stickers > v
LV IR V) —
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* From the content inside your current painting.
o If you have a stencil or ruler in your canvas you can right-click to bring up the context menu
o From the menu choose ‘Send to a Friend’
o Alist of your friends who are currently also connected to the PaintLink server will appear.

o Select the friend you want to send the content to.

+  Stencil Mode
Ruler Mode
Guide Mode

Flip Stencil Horizontally
Flip Stencil Vertically
Set Stencil Angle...

Invert Stencil

Reset Pin Position
Reset Stencil Scale

Hide Stencil

Remove This Stencil
Add To Collection...

Add To Toolbox

Send to Friend > vin_goff |

* From the ArtRage Menu.
o Open the ArtRage ‘Tools’ menu, and select a content-type sub-menu (for example ‘Grids’
o From the menu choose ‘Send to a Friend’
o Alist of your friends who are currently also connected to the PaintLink server will appear.

o Select the friend you want to send the content to.

T3 ArtRage - Untitled
File | Edit | Tools | View | Help |@|<| 4| <3| |[f) united

Cl== Select Tool >

‘+‘ Default Settings
Brush Designer
Sticker Spray Variants
Tool Presets Ctrl+Alt+P
New Preset... Ctrl+Shift+P
Toolbox Options >
Color Options >
Color Sample Options >
Layer Options >
Stencil Options >
Tracing Options >
Reference Options >
Layout Panel
Grids. > Show Grid
Guides > Snap To Grid
Perspective > Save Grid...
Paint Symmetry > Manage Grid Sets...
Actions > Send to Friend > vin_goff |
Browse Content Folders >

PaintLink >
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There are other places you will see a ‘Send to Friend’ option inside ArtRage. You can send the content to any
of your ArtRage PaintLink friends who are currently connected to their PaintLink accounts.

What do to when | receive something
When you’re chatting with a friend they may send you an ArtRage paint tool or stencil or reference image or
any of the other things ArtRage can send.

* ArtRage will pop up a notification in the top-right of your ArtRage window.

llem Received: Tool Seftings - Pencil(6) | Q| + | (@

* From the notification you can view the Friends %
incoming file in your chat window by raa
clicking the chat bubble icon, or b &
immediately add the asset to your own ® = QO+
ArtRage painting by clicking the ‘+" icon.
[ ' Q A
A vin_goff —
N —g E
Q
brain2000 —
8
Q
arfragemac —
=]
: Q
andyrage 5 v
Chatting With... X
M vin_goff >
* From the chat window you can ﬂ [A
. ? Tool Settings - Pencil(6)
add the item to your own R > i
. . ’ ow
ArtRage pamtmg by using the This is the nice pencil | used for the Dragon sketch. View in Collection...
menu at the right of the file.
Choose ‘Add now’ ﬂ Oh awesome, thanks! :)
Vv
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Collaborative Painting - Share a Canvas with a Friend:

ArtRage Vitae allows you and a friend to work on the same canvas at the same time. It doesn’t matter if your
friend is in the same room, or on the other side of the world. ArtRage will update your canvas as your friend
paints, and ArtRage will update your friend’s canvas while you paint. You can add layers and use all the tools
you’re used to and your friend will get the same result.

Start a PaintLink Session.
* Before you can start a shared canvas with a friend you both need to be running ArtRage Vitae, and
you both need to be connected to the Internet and logged in to your PaintLink accounts: [Getting
Started:]

* When you're both ready you can start the shared painting session from the menu in your chat
window to your friend. Click the >’ icon and select ‘Start a Painting Session...’

Chatting With... X
m vin_goff > Start a Painting Session...

B = About this Friend...

A

ﬂ Oh awesome, thanks! :)

@ No probs.

ﬂ Hey, wanna work on a painting together?

@ Sure thing! I'd love tol

ﬂ Coolness. I'll start the shared canvas now. v

| >+

* Your friend will receive a notification that you are wanting to start a shared painting session.

Paint Session X

e

They can choose to accept the shared session, or ignore it.

If they accept, ArtRage will synchronise your canvases so you

vin_goff wants o paint. and your friend are both starting with the same painting
settings. It will also send over any painting and layer content you
Q X v may already have started.
Paint Session X
vin_goff Q When you've successfully connected for a shared canvas the

ArtRage PaintLink Paint Session panel will show ‘Connected’.

Connected

Disconnect



ArtRage Vitae - PaintLink Manual. Page 16

Paint on a shared canvas.

Now that you’re connected for a shared canvas you can paint, add layers, add effects — use all the features of
ArtRage you’d normally use to create art. And all your work will also show up on your friend’s canvas. And
all their work will show up on yours.

Layers B | X
A
* When the PaintLink session synchronises your ArtRage Canvas with
your friend it adds a new layer to the painting. This is so you and
your friend are painting on separate layers.
* You can add new layers, which you will be allowed to paint on. And " oo
your friend can add new layers which they can paint on. |:, vin_go
* You can move your own layers around in the layer stack, delete them, I:I jsmith34
change blend modes and do all the other layer operations on your =X
own layers only. o ] il

* Layers that belong to your friend will appear greyed out, and you —
can’t paint on them.

Layers B | X

>Annotation

.

a ")
= [ oseen &
® B v LayerVisible
-— Layer Locks >
- Black Paper
Qo Layer Effects...
* |If you want you can allow your
. . g Mid area Set Layer Name...
friend to paint on one of your Set Layer Opacity..
layers by transferring ownership Edit Layer Texture...
to them. You can do this from EMW”""“ e ot ,
the Layer menu for your layer: Bump Blend Modes >
[ Jseyseck
Transform Layer Contents... Ctrl+Shift+Alt+T
+ = ] Duplicate Layer
i Clear Layer

Delete Layer
Merge Layer Down Ctrl+Alt+Down
Close Layer Group

New Stencil From Layer Contents

Select Layer Contents Ctrl+Alt+A
Add to Toolbox

Export Layer... Ctrl+Shift+E
Export Layer To Channels... Ctrl+Shift+ Alt+E

Transfer Ownership
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Layers B | X

>Annotation

LK)
g
Pl o

Request Layer Ownership...

* If you want to paint on a layer owned by {:IDS"Q’C"
your friend you can request ownership of

—
. Black Paper
the layer: ° - P

* Your undo and redo painting operations will work and will update your friend’s ArtRage canvas as
well.

* Really, you can just paint like you normally would, except that your friend can share in your work as
well.

Some things aren’t shared.
* Not everything you do on your painting is shared with your friend. While you’re working on your
canvas you may want to use grids and guides, or reference images, or stencils. These are tools to
help you work on your layer content and could interfere with what your friend is working on.

* They can have their own sets of guides and references which you don’t see on your canvas.

* If you need to you can send your reference images, and guide sets, and stencils across to your friend
and they can add them to their painting.

What if we're interrupted?
You might want to work on a long project that will take more than one shared painting session. Or your
Internet link may go down.

* Firstly, save your work often. Both you and your friend should save your work regularly.

* When you want to resume your work, make sure you’re both connected to the Internet and logged
in to your PaintLink accounts: [Getting Started:]

* Both you and your friend should load the same ArtRage painting you were working on. ArtRage
keeps a record of who you were sharing a canvas with.

* Now start a shared PaintLink session with your friend: [Start a PaintLink Session.]
* ArtRage will resynchronise your layers and content and you can resume your shared session.

* Layer ownership will stay how it was at the end of your previous session.
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Sharing a work in progress
You can also start sharing with a friend an ArtRage painting you’ve already worked on alone.

Make sure you and your friend are both connected to the Internet and logged in to your PaintLink
accounts: [Getting Started:]

Load the ArtRage painting you want to share.
Now start a shared PaintLink session with your friend: [Start a PaintLink Session.]
ArtRage will synchronise your layers and content with your friend.

All the layers in the painting will be owned by you except for one layer PaintLink will create for your
friend.

If you need to you can transfer ownership of some of your existing layers to your friend: [Paint on a
shared canvas.]

If it all goes wrong...
Many things can cause a shared painting session to ‘break’. If it looks like your shared ArtRage canvases have
stopped updating try the following.

Save your ArtRage painting.
You may need to ‘Disconnect’ in the Paint Session panel.

Try to re-start the PaintLink session with your friend. Just restarting the PaintLink session may re-
synchronise your ArtRage canvases and you can carry on.

If that fails, both of you should try shutting ArtRage down, and then restarting ArtRage.
Then both of you should reload your paintings and re-start your PaintLink session: [What if we're
interrupted?]

If one of you has lost your shared canvas you can still resume painting as though you’re loading an
existing ArtRage painting that wasn’t previously shared: [Sharing a work in progress]
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